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Introduction

The AVANT Stealth Audiometer represents a new era of PC-based diagnostic audiometry for your office.
This PC-Based system supports current ANSI and IEC audiometric tests. This manual assumes that the
system hardware and software are installed and working properly. Please refer to the MedRx AVANT
Stealth Audiometer Installation Manual for assistance. The AVANT Stealth Audiometer Installation
Manual is included in the original AVANT Stealth Audiometer packaging in both printed and PDF
formats.

The scope of this manual is to get you “up and running” with the AVANT Stealth Audiometer System.
Please consult the interactive Help System within the software for more detailed information of features
and functionality. To access this tool, press the F1 key at any time, or click the Help icon or the menu bar
with your mouse.

ADP-I-MADPT-3 MedRx AVANT Stealth Training Manual Page 4
Effective Date: 06-01-2015



The AVANT Audiometer
Software

General Overview

The AVANT Audiometer software can run stand-alone or through the NOAH™ System or the TIMS®
Office System.

Launching the Software
Stand Alone NOAH and TIMS

1. Launch NOAH.

2. In NOAH 4.
e Click AVANT Audiometer icon on the
toolbar.
fanamll AVANT
1. Double click the AVANT Audiometer \._/ AUDIOMETER
shortcut on your Windows Desktop.
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Software Options

Basic Options

Several option screens are available which allow the user to customize the AVANT Audiometer

Software to meet their needs.

Access these options from the File Menu on
the AVANT Audiometer Main Screen as
shown below.

IHH Function Help

Print Sebup, ..
Page Setup. ..

Clear Session Data

Advanced Eginns. "

Exit:

The Options may also be accessed from
the Audio screen by clicking Options on
the menu as shown below.

File Function Ear Output Audio  Stimulus

Audiometry SRT Wh

The screen shots below detail the Basic Options available in the AVANT Audiometer software.

Options
View lwcliometry] MHA/HLS | Tymp |

Flot
[ ertical Grid

Speech Spectium
v Cance
v Harizantal Grid ¥ Speech Sounds

Sight Language:

Style; | Lines hd
Size: |70

[ Dual Plat Mode

=l

<Drefault

Default Ear: | Right -

Flot Curves Width: | Medium  +

[ Reverse Ears

¥ Maintain Plat Ratios ¥ Usze Plat Antialiazing

X

=]

Cancel | Help

Options

View  Audiomelry | MHA/MLS | Tymp |

Amow Buttons

Mewve Up by [dB]: EI:

Move Down by [dBT |10 -2

Inzerts -

Defaul Level (dB) [0 |
Default Tone: ’W‘
Speech Scoring: ’m
Default Speech Input: ’m

v Auto Advance Wwords

Advanced
Tranzducers

Default Output;

[ Awto Saund

[ Reverse Kepboard Arows

[ Rewverse Level Contrals
Lewel Linit
+ 548 1dB

V¥ Enable Operator Headset

¥ Enable Talkback Microphone

=]

Cancel | Help

The View tab allows you to set the
default appearance of the test screen.
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The Audiometry tab sets the look and
behavior of the AVANT Stealth Audiometer.
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Option 1: On the Audiometry Options screen Option 2: You can change transducers by

click Transducers to assign specific Right-Clicking on any transducer icon on the
transducers to the audiometer outputs. Audiometry screen.

ce Wonds, Limit: |25 'I n
4q
‘ oT HIFLADON
Advanced Mask With
Transducers I I E Change Transducer _:
| Close
Zanced | Hep | |

The Transducers dialog box will then appear. Select the appropriate transducer for each output.

x
Headset AC-1: [EAR Tone =l
Headset AC-2: [TDH39 =l

x

Bone Conductor:
Select Enabled Outputs:

[w] &ir Conduction - 1
Outputs (v Air Conduction - 2

[w]Bone Conduction

[w]Free Field - Line Out

[w]Free Field - Loudspeakers

CK I Cancel |

To add or remove outputs, click Outputs to enable or disable transducer buttons on the
Audiometry screen

Options [Z| Options rg'
View | Audiometry MHAJIt%S | Tymp | View | Audiometry | MHAMLS Tymnkl
FHA,
Clutput:

¥ Show The Narm Area Scaling |Auto -
Default Level: |50 _I;I W Auta Switch Modes

MHA Simulation: [Nomal _+]

Live Input Equalizer: | Software [flevible response, delay) ﬂ

v Interpolate Curve

HLS

Output: | Speakers ﬂ

Default Level: |50 _|:|
HLS Simulation: | Mormal b

oK. | Caniel | Help | Ok | Cancel | Help |
The MHA/HLS tab sets the default look and If your system has a Tympanometer
behavior of the Master Hearing Aid and connected, this tab will assist in
Hearing Loss Simulator. configuring the look of the display.

NOTE: Remember, that more information is always available in the Interactive Help System by clicking
the Help Icon or pressing the F1 key.
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Advanced Options

The Advanced Options screen allows you to
configure your system to meet your individual
clinical needs. It also provides MedRx
Technical Support with tools for helping you
troubleshoot technical issues. Access this
screen from the File Menu on the AVANT
Audiometer Main Screen as shown to the right.

Avant Audiometer

Function Help

Prinkt Setup...
Page Setup...

Clear Session Data

Options...

Exit

The key features of each tab are described below. For more in-depth information, consult the interactive
Help system within the software by pressing the F1 key or clicking the Help icon.

x
Genersl IMd\o | Video | Tymparmme{ryl
CD-ROM Drive ID' =2
Device Manager
Control Panel
System Information

The General Tab configures the overall AVANT

Stealth Audiometer behavior with respect to
other Windows programs, specifically NOAH.

x
.Geﬂemll Audio  Video ITympammetryI
r~ Ctoscope Input
Source Format Adjust
r Altemative Input
Device: |Not Available j
Source Format Adjust
ok | caed | Heo |

If your system has a Video Otoscope, the
Video Tab allows you to select the appropriate
device driver.
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Advanced Options x|

General Audio |V‘|deo |Tympaﬂome*try|

Cutput Device: |3

Input Device: [ Line (4- USB Audio Devics) =l
Output Mixer: |4 USE Audio Device j
Input Mixer: Id- USE Audio Device j

Microphone Gain {dB): |12 -

Carcsl | Hep |

o

Use the Audio Tab to select the proper audio device
for your AVANT Stealth Audiometer. This tab also

provides access to the Windows Audio controls. Note:
The device settings may vary with different computers. Consult
technical support before changing.

Advanced Options |

"General | Audio | Video  Tympanometry |

Tympanometer:

Cacel | Heb |

o]

If your system has a Tympanometer connected, use
this tab to identify it and ensure the driver and
software that control it are correctly installed.
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Preparing for Testing

Connecting the Peripherals

After you install the software for your AVANT Stealth
Audiometer you need to connect the rest of the
peripherals before testing a patient. (See the AVANT
Stealth Audiometer Installation Manual).

Using the pictures below, locate each of the
accessories and plug them into the labeled jacks on
your Stealth.

The External Power Supply is required to utilize the
built-in 2x20 Watt Amplifiers and the High Frequency
Option.

IP30 Insert Earphones
(Standard)

Insert Earphones TDH-39 or DD45 HDA 200 (Optional) Operator Mic & Speakers (Optional)
(Optional) Earphones High Frequency Monitor

4

>

Bone Conductor Power Supply USB Cable Patient Response Talkback Mic
Switch
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Placing the Earphones on the Patient

The AVANT Stealth Audiometer standard configuration includes IP30 Insert Earphones. 3A Insert
Earphones, TDH 39 earphones are also available by request. The figures below illustrate how to
properly place these earphones on the patient.

Insert Earphones

IMPORTANT: The foam tips used for the insert earphones are for SINGLE PATIENT USE ONLY. Do not
attempt to wash and re-use them.

1. Place a new set of foam tips on the earphone tubes as shown.
These tips are designed for single patient use and should not be
washed and reused.

e NOTE: When removing foam tips after use, be sure the clear
plastic tubing nipple remains attached to the long earphone
tube.

2. Carefully compress the tip between
your fingers to allow it to fit into the
patient’s ear canal as shown. Do not
roll the tip between your fingers.

3. Pull up and back on the patient’s
pinna to straighten the ear canal.

4. Place the compressed foam tip deep
within the ear canal.

5. When properly placed, the outer
surface of the insert tip will be flush
with the opening of the ear canal as
shown.
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TDH 39 Earphones

1. Place the earphones on the patient’s
head so the center of the earphone
is directly over the opening of the ear
canal.

2. Adjust the headband so the
earphones remain in place, but be
careful not to make it so tight as to
cause patient discomfort.

Note: The HDA 200
Earphones are part of an
upgrade option for the AVANT
Stealth Audiometer. If you
need to test frequencies
beyond 8000 Hz, you must
notify MedRx. This option
carries a price differential
which will be detailed at the
time of order.

1. Place the earphones on the patient’s
head so the center of the earphone
is directly over the opening of the ear
canal.

2. Adjust the headband so the
earphones remain in place, but be
careful not to make it so tight as to
cause patient discomfort.

Placing the Bone Conductor

N 1. Locate the mastoid process behind the pinna. This is
a bony shelf just behind where the ear meets the
head.

2. Carefully place the bone conductor on the mastoid
process and hold it in place.

3. Place the headband over the head to the opposite
temple.

4. Carefully and slowly loosen your grip to check if the
bone vibrator and headband will stay in place.

5. If either moves, reposition until both the headband and
bone vibrator are secure.
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Performing Audiometric
Testing

From the AVANT Audiometer home screen, click on the “Audiometry” tab to access the audiometry function.
The screen shot below shows the controls which are available from the AVANT Audiometer main window.
The sections of the manual that follow explain how to use these tools to perform hearing evaluations using
your AVANT Stealth Audiometer.

R
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Test selection tool bar

Ear selection

Output selectors

Test Type Selectors
Tone Type Selectors

Output Level Potentiometers

Masking interrupter and routing selector
No Response button
Patient Response Indicator

@B @D

10. Test Interrupter
11. Back To The Main Screen
12. Help
13. Discard Current Measurement

14. Talk Over
15. Legend

To exit the program, click on the “Back” button then click “Exit”.
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Pure Tone Audiometry

Pure Tone Audiometry measures the patient’s peripheral hearing sensitivity, or the softest levels they
can hear pure tones at a variety of frequencies. These thresholds are plotted on a standard graph called
an audiogram. The AVANT Audiometer software controls the hardware, stores the data (if running
within NOAH or TIMS) and prints a standard audiogram report. Pure tone Audiometry can be performed
via earphones, free field speakers (Air Conduction) or a Bone Conductor (Bone Conduction). Warble
settings are adjustable by the Operator. The Sound Field must be calibrated on-site, using 4 ochm
speakers connected to the Free Field connectors.

Pretesting Procedures/Recommendations:

e Before performing audiometry, careful inspection of the ear canal should be performed. This is
best done with Video Otoscopy. After ensuring the ear canal is clear, place the appropriate
transducer on the patient as shown on pages 10 & 11.

Pure Tone Audiometry via Earphones (IP30 Inserts, 3A Inserts or TDH 39)

1. From the Main Window, click the | &dere & button on the right side menu bar.
Audiomatry
2. By default, the L+ button will be selected once you enter the main Audiometry Screen.
Other default settings (based on typical clinical practice and procedures) are:
e Right Ear
¢ AC (Air Conduction)
e Tone Stimulus
e Continuous Tone

3. Instruct the patient that they will hear several very quiet (soft) tones (beeps) and that they should
signal (raise their hand, press the patient response button, etc.) as soon as they hear it. Itis
helpful to also say “even if it seems very far away”.

4. Begin at 1000 Hz in the Right ear (unless the patient reports better hearing in the left ear).

Present a tone at 60 dB by pressing and holding the space bar or clicking and holding the

[ ] Test
% button.

6. If the patient does not hear the tone (does not signal), raise the level 5 dB using the up arrow on

£

7. Repeat step 6 until the patient signals that they hear the tone.

your keyboard or by clicking the button and present again.

8. When the patient signals they hear the tone, decrease the level by 10 dB using the down arrow

£

on your keyboard or by clicking the button and present the tone again.

9. Repeat steps 6 through 8 until the patient responds to a tone at the same level 2 times with the
level ascending and establishing a threshold.

10. Using the right arrow key, change the test frequency to 2000 Hz and repeat steps 5 through 9 to
establish the threshold at 2000 Hz. The threshold at the previous frequency is recorded when
the test frequency is changed.

e NOTE: If the threshold at 2000 Hz is more than 20 dB different (less than or greater
than) the threshold at 1000 Hz, repeat steps 5 through 9 at 1500 Hz (the “half octave”
between 1000 Hz and 2000 Hz).

11. Repeat steps 5 through 9 for 4000 Hz, 8000 Hz, 500 Hz and 250 Hz. Testing half octaves as
needed.

12. Repeat steps 4 through 11 in the opposite ear.
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NOTE: The software automatically calculates the 3-frequency Pure Tone Average (PTA) which is
displayed above and inside the legend as follows:

PTA Right: 60dB

—— A Conduction, A=0%, PTASGD

Pure Tone Audiometry via the Bone Conductor

1. Following the instructions on page 11, place the Bone Conductor on the mastoid process behind
the ear with better air conduction thresholds as measured above. If the thresholds are equal,
place the Bone Conductor on the mastoid process behind the right ear.

2. Establish pure tone bone conduction thresholds as described above for 1000 Hz, 2000 Hz, 4000
Hz, 500 Hz and 250 Hz.

3. If the Bone Conduction (BC) threshold at a given frequency is less (better) than the Air
Conduction (AC) threshold by 15 dB or more, you must confirm the threshold by performing
masking. Masking is always recommended for frequencies above 2000 Hz to achieve valid
results.

4. Repeat steps 1-3 for opposite ear.
Masking for Pure Tone Audiometry

There are several accepted methods for masking. This manual will not promote one over another,
however, to use the masking function on the AVANT Stealth Audiometer, follow the steps below.

1. Click the Masking button. The red light will appear indicating that

@ Masking the masking is on.

et | O 2. Use your mouse to adjust the Masking Level slider shown on the
50 dB || &0 dB left to the appropriate level based on your preferred method of
_ - masking.

I

- - 3. If you wish to maintain the balance of signal and masking (for
ey =y ﬁ example, masking always 30 dB above the signal), click the Lock
K g button after setting the masking and signal levels.

4. The default for pure tone audiometry is to deliver narrow band
@  Masking v masking to the ear opposite the test ear. If you wish to use a
different stimulus, or route the masking to the same or both ears,
click on the arrow to the right of the Masking On button.

5. Use your mouse to select the new masking type and routing for
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your specific application.

{ = 6. When you are finished making changes to the Masking, click

{ SameEar Close.
Both Ears

w Marrows Band Moise
Speech Weighted Moise
‘White Maise

Close

Optional High Frequency Audiometry

The AVANT Stealth Audiometer is available with the option to perform extended range high frequency
pure tone audiometry. This is used clinically to evaluate noise induced hearing loss, ototoxicity and
tinnitus. High frequency testing uses the same procedure as described on page 13 for pure tone
audiometry.

_ To start High Frequency audiometry, select a transducer that
Momal (| Pl || Hi Fieq supports high frequencies, such as the HDA 200.

The High Frequency control will appear on the right panel and will
allow choosing frequency ranges to be shown on the plot. The
power supply must be connected to activate the high frequency
control or when using the free field amplifier.

NOTE: Extended High Frequency Audiometry is an upgrade option for the AVANT Stealth Audiometer.
If the high frequency control selectors do not appear on the right panel and if you need to test
frequencies beyond 8000 Hz, you must notify MedRx. This option carries a price differential which will be
detailed at the time of order.

Speech Audiometry

Speech audiometry evaluates how well the patient can hear and understand speech. The typical test
battery includes tests of speech thresholds and tests of speech discrimination.

The sections below detail how to perform these tests on the AVANT Stealth Audiometer.
Speech Reception Threshold (SRT)

The Speech Reception Threshold (SRT) is defined as the lowest dB level at which the patient can repeat
Spondee words with at least 50% accuracy. Spondee words are two syllable words with equal vocal
emphasis on each syllable such as “baseball” or “hotdog”.

Instruct the patient that they will hear a series of two-syllable words that will get quieter as the test
progresses. They are to repeat the words as best they can, even if they sound very far away. If they are
not sure of a word, they should take a guess.

SRT is typically within +/- 5 dB of the patient’s PTA which is displayed on the lower left corner of the
screen. Set the level of the test signal to “a level of familiarization”, done typically 20 dB above the PTA.

1. From the AVANT Audiometer main screen,
click the Audiometry button.
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2. Click the SRT button located on the toolbar on
SRT
the top of the screen.

EE—— N

$ 3. Select the appropriate test ear icon.

Left Ear Right Ear
‘ ord Lint 4, Click the Word List button.
Speech Audiometry X 5. Select Spondee Word Lists A&B from the

list.

6. Click Start Test.

NU-G List 3 Form &
PBE-B0 List T Farm &

PBE-50 List 2 Form &
PBE-50 List 3 Farm &

| Start Te% Cancel Help
' ' i 7. Click the Play button or press the F9 key to
Play o present a word. The word will play through

' ! the chosen transducer as well as display on
the screen.
@ % CSpore | BOZ 8. If the patient correctly repeats the word, click
: the Correct icon or press F7.
\ Total: | & P
Comect; 3 ) ) ]
£1 Start Signal Incorrect | 3 9. If the patient incorrectly repeats the word, click

the Incorrect icon or press F8.
Note that the score is calculated and displayed automatically in the bottom right corner of the screen.

If the patient exceeds a 50% score at a given presentation level, stop the test and decrease the level by
10 dB and repeat the steps above.

If the patient fails to achieve a 50% score after 6 words at a given level, stop the test, raise the level 5 dB
and repeat the steps above.

When the patient scores 50% at a given level, the test is complete. The software automatically plots the
score on the SRT graph.

Repeat test on opposite ear.

Word Recognition (WR)

Speech Discrimination or Word Recognition (WR) is a discrimination, type test using speech as the
stimulus. WR testing measures the percentage of mono-syllable words repeated correctly from a list.
Unlike the SRT test, the WR test is performed at a fixed intensity (dB) level. WR is typically performed at
a patient’s speech MCL. If MCL is not performed, system default options include, PTA, PTA+20, PTA+30
and PTA+40.

Before beginning the test, instruct the patient that they will hear a series of one-syllable words. They are
to repeat the words as best they can. If they are not sure of a word, they should take a guess.
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Speech Audiometry

Word Lisk:
Spondes Word List ALE
s p

wh
g 9 ‘
Left Ear Right Ear
| word List

®

t 2 Form &
W22 List 3 Farm &
NU-G List 1 Form A
NU-E List 2 Form A
NL-E List 3 Form A
PEK-50 List 1 Form A
PEK-50 List 2 Form &
PEK-50 List 3 Form &

Start Test, Cancel Help
b

| Play l |-
il

=

#* Score: | 92%
25

Tatal:
Incomect

- Stait Signal Incorect: 2

Corect: 23

From the AVANT Audiometer main screen, click the
Audiometry button.

Click the WR button located on the toolbar on the top
of the screen.

Select the appropriate test ear icon.

Click the Word List button.

Select the desired Word List from the list. The W-22
or NU-6 lists are good choices for most adult
patients. When testing children, the PBK lists should
be used.

Click Start Test.

Click the Play button or press the F9 key to present a
word. The word will play through the chosen
transducer as well as display on the screen.

If the patient correctly repeats the word, click the
Correct icon or press F7.

If the patient incorrectly repeats the word, click the
Incorrect icon or press F8.

Note that the score is calculated and displayed automatically. The test is complete when all words in the
list have been presented. The software automatically plots the score on the WR graph.

Repeat test on opposite ear.
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Hearing Loss Simulator

The Hearing Loss Simulator (HLS) demonstrates the effect of the client’s hearing loss for the
significant third party. The program attenuates an input signal to simulate the audiogram. The
third party listens to the free field speakers. The third party can hear how their own voice is
distorted by the hearing loss when the Record input option is used.

The Hearing Loss Simulator requires the client’'s Audiogram data. This data can be manually entered in
the Audio screen of this or any other task.

How to perform the Hearing Loss Simulator task
e Select the HLS tab on the toolbar.
e Enter the Audiogram values manually if the data is not automatically imported to this screen.

e Select the input signal type: Mic, File or Record. Select the track and the Play button on the
control panel. See below for instructions on how to use the Record option.

e The HLS output is directed to the free field loudspeakers.

e Select Normal to play the input signal as a person with normal hearing would perceive it. Select
Simulated to turn on the simulation of the client's hearing loss. Toggle between these selections
as necessary.

e The Reset option restores the audiogram to the original state. Use this option if you have
modified the audiogram but want to undo the changes. The changes to the Audiogram that are
made on the HLS screen are temporary and will not affect the client's original audiometry record.

¢ A volume control adjustment bar allows for manual adjustment of the output level of the free field
speakers.

e To stop the playback, select the Stop button on the player.
Note: It is recommended you use a variety of tracks from the list to demonstrate the hearing loss.
Record Input Option

This option allows recording and playing back of the voice of the third party.

Master Hearing Aid

Master Hearing Aid (MHA) is an alternative to using a stock hearing aid to demonstrate the benefits of
amplification to an inexperienced user. The system applies the fitting rules by default to the patient's
audiogram and simulates a hearing aid. The patient listens to this signal through the headphones.
Options for editing the gain applied to the audiogram are provided.

About the Master Hearing Aid Display

The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and Frequency in Hz
on the horizontal axis. The plot on the graph represents the gain applied to the patient's Audiogram. The
NAL-RP is applied by default. A new rule can be selected from the list on the right side of the display. A
volume adjustment bar allows for manual adjustment of the output level. The control panel on the right of
the display provides options for input signal source and the task icons for Normal and Simulate.
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The Master Hearing Aid applies gain separately for each ear. If audiogram values are entered for the
left and right ear, the selected fitting rules will be applied to each ear separately. Different rules may be
entered for different ears (i.e. NAL-RP for left ear and BERGER for right ear). If an audiogram is entered
only for one ear, the gain will not be adjusted for the opposite ear and the sound for that ear will be
normal.

If Binaural mode is selected, the sound will be heard from both channels (left and right). If Monaural
mode is selected, the sound will be heard only from the channel corresponding to the active ear when
the channel for the opposite ear will be muted.

Input signal

Live voice (microphone) allows you to use the talk-over microphone for live speech input to the
inserts. The clinician or significant third party can speak into the microphone for this activity. Note: there
is a processing delay between the input and playback. Make sure that the client cannot hear the voice
directly but only through the headset. If this is not possible, use the Recorder (describer below) to
simulate speech input.

File allows the user to play sound files. The program supports MP3 and WAV files and comes with pre-
set MedRx Sounds Sensations sound files. After the option is activated, use the player panel to control
the playback.

CD allows the user to play music CDs. After the option is activated, use the player panel to control the
playback.

Record input mode allows the clinician or third party to record a sample of their speech which can then
be replayed for repeat comparisons under different amplification conditions for the patient. Refer to the
interactive Help system by pressing F1 or clicking the Help icon to learn more about the recorder.

How to use the Master Hearing Aid:
1. Select the Master Hearing Aid (MHA) icon from the main screen.
2. Enter the Audiogram values manually if the data is not automatically imported to this screen.
3. Select the input signal type: File, CD, Mic, or Record.
4. Select Monaural or Binaural.

5. Select the Normal icon, which will send the input signal through to the inserts without
modification. The patient is listening to the signal without any amplification benefit. Select the
Simulate icon to modify the input signal according to the selected rule. This selection allows the
patient to hear the benefits of amplification. Toggle between these two selections as necessary.

6. If the simulated frequency response needs to be adjusted, based on feedback from the patient,
manually edit the response by clicking on the gain curve at the desired frequency and new gain
level. The gain curve of the selected test ear on the control panel can be edited. To edit the
other ear, click the appropriate test ear icon on the control panel first.

Hint: Use the track return icon on the player control panel to replay one track continuously.

| =l
Time: - ] | |
M W ]

(s =] [

The Reset option restores the rule to the original state. Use this option if you have modified the rule but
want to undo the changes.
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Printing

Printing within the AVANT Audiometer software is very simple.

*. Avant - Audiometry [Audiogram]

FEM Function Ear Output  Audio  Stimuly

Open
Save

Clear Session Daka

Prink Setup... %

Print Presvigws
Prink...

50 Back, Ctrl-Back,
Exit alt-F4

|
B |

From the File menu, click one of the following options:

Page Setup — Allows you to set margin sizes and the
default text header for your reports.

Print Setup — selects the printer you want the report to be
sent to.

Print Preview — Shows you what your report will look like
before you print it.

Print — Sends the report to the printer. This option opens
the Windows Print dialog which allows the user to select
any installed printer and modify the properties (quality,
number of copies, etc.) for the print job.
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Limited Warranty

MedRx, Inc. warrants this product to be free from defects in material and
workmanship for one year from the time of purchase. If this system fails to perform
as specified during this period, the purchaser is responsible for calling MedRx at
(888) 392-1234 or (727) 584-9600. The company's representative will advise the
owner to either return specific components or the entire system to:

MedRXx, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA

MedRx will repair or replace any defective devices, fully test the system and/or
components and ship the system promptly back to the owner. There is no cost for
the repair or return shipping, provided the system is one year old or less and has not
been misused, abused or damaged. Such damage includes, but is not limited to,
dropping, exposure to excessive heat greater than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and
exclusive remedy of the purchaser. MedRx shall not be liable for any consequential
or incidental damages or for breach of any express or implied warranty. Except to
the extent of applicable law, any implied warranty, merchantability or fitness of this
product is limited to the duration of this warranty.

MedRx will, at its discretion, service and repair out of warranty products at the
purchaser's request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on this
product which is not pre-approved by MedRx, Inc. Approved software includes
NOAH" and HIMSA approved hearing aid manufacturer programming modules for
fitting hearing aids.

MedRX, Inc. is not responsible for problems resulting from installation of unapproved
software or hardware. In the event of unapproved software or hardware installed on
the system causing a conflict, MedRx will service the product for a fee to be
determined at the time of service.

Any extension of this warranty past the initial one-year warranty is subject to the
following (where applicable).

1. A $300 deductible per repair.

2. Extended warranty does not include cables, connectors or peripherals.

3. Extended warranty of the Video Otoscope covers optics only.
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Toll Free: (888) 392-1234  (727) 584-9600
Fax: (727) 584-9602 ¢ Email: medrx@medrx-usa.com

m MedRx's Authorized Representative in Europe
(Regulatory affairs only)
Emergo Europe, Molenstraat 15
2513 BH The Hague, The Netherlands
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